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Using redaction in Adobe® Acrobat® X
Best practices for removing sensitive text and images from documents

Redaction is the permanent deletion of visible text and images from documents. In the past, a black marker 
was used to hide sensitive information. These days, it doesn’t make sense to print out a document just to 
redact it. The process is slow, expensive, and inefficient. Instead, law firms, government agencies, and 
organizations around the world rely on Adobe Acrobat Pro software to safely and permanently remove content 
from the document data stream.

Acrobat redaction tools were introduced in version 8, and redaction capabilities have continued to improve 
with each release. In Acrobat X Pro, several new redaction features were introduced:

•	 Redaction	across	pages—Repeat	a	redaction	through	a	document.	Useful	for	redacting	headers	and	footers	
from documents.

•	 Partial	pattern	redaction—Mark	part	of	a	pattern	for	redaction.	For	example,	mark	part	of	a	national	ID	or	
credit card number. Useful for identifying individuals without revealing personal information. 

•	 Redaction	mark	appearance—Set	the	appearance	of	redaction	marks.	For	example,	mark	items	with	a	
transparent red overlay. 

•	 Overlay	text	in	Comments	list—View	overlay	text	in	the	Comment	list	for	quick	review.

This paper provides tips for getting started and best practices for using the redaction tools in Acrobat X. 
Topics covered include:

•	 Setting	redaction	preferences

•	 Marking	text	and	graphics	for	redaction

•	 Setting	common	redaction	properties

•	 Adding	overlay	text	and	exemption	codes	to	a	redaction

•	 Creating	a	report	of	redactions

•	 Applying	redactions	to	permanently	remove	information

•	 Using	Actions	to	automate	the	redaction	workflow

Preparing for redaction 
Redactions must be carefully applied and managed. Here are a few tips to get ready.

•	 Copy	the	documents	to	be	redacted	to	a	new	folder	on	your	hard	drive.

•	 If	the	document	is	a	scanned	image,	convert	the	image	to	searchable	text	using	optical	character	recognition	
(OCR).

•	 Review	the	documents	to	identify	the	type	of	information	that	needs	to	be	redacted.	For	example,	personally	
identifiable	information	(PII),	such	as	driver’s	license,	national	identification,	or	credit	card	numbers	that	can	
be used to identify, contact, or locate a person; names of companies or people that need to remain confiden-
tial; or trade secrets such as formulas or computer code.
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The following diagram illustrates a suggested workflow for redaction.
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Example redaction workflow

Automatically copying redacted text to a sticky note
A redaction mark acts like a comment until you apply the redaction, which then permanently removes the 
information. A best practice is to set your preferences to automatically copy text into a sticky note, which are 
compiled	in	the	Comments	pane.	Using	sticky	notes	makes	it	easier	to	review,	edit,	and	delete	what	is	marked	
for redaction.

1.	 Choose	Edit > Preferences	(Windows)	or	Acrobat > Preferences	(Mac).

2.	 In	the	Categories	list,	click	Commenting. 

3.	 Select	Copy Selected Text into Highlight, Crossout, and Underline Comment Pop-ups.

4.	 Click	OK.

When	you	select	text	using	the	Mark	for	Redaction	tool,	the	text	is	automatically	copied	into	a	sticky	note	and	
placed	in	the	Comments	list.
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Redacting text and graphics
Use	the	Mark	for	Redaction	tool	to	select	text	and	graphics	that	will	be	removed	from	the	document.	The	
cursor changes depending on the type of content.

Note:	Marking	an	item	for	redaction	only	flags	the	item	for	redaction.	To	finalize	the	redaction,	you	must	apply	it.

To select the redaction tool:

1. In the Tools panel, expand the Protection section.

2.	 Select	Mark for Redaction.

To redact text:

1.	 Select	the	Mark for Redaction tool.

2. Hover the cursor over the text that you want to redact. The cursor becomes a text selection cursor ( ).	

3.	 Select	the	text	to	mark	it	for	redaction.	

Tip:	Did	you	select	too	much? 
Press	Ctrl+Z	(Windows)	or	Command+Z	(Mac)	to	undo	the	redaction.
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To redact a graphic or image:

1.	 Select	the	Mark for Redaction tool.

2.	 Hover	the	cursor	over	an	image.	When	the	crosshair	cursor	(+)	appears,	you	can	select	the	image.

3.	 Draw	a	rectangular	selection	around	the	area	to	redact.	Everything	within	the	selection	area—images,	text,	
and	vector	objects—is	removed.	

Still can’t get a crosshair cursor? 
Sometimes	it	is	difficult	to	select	an	entire	area	that	combines	text	and	graphics.	To	get	the	crosshair	
cursor	(+)	for	an	area	redaction,	hold	down	the	Alt	(Windows)	or	Command	(Mac)	key.

 

Tip for redacting a photo 
To	select	all	the	pixels	in	an	image	for	redaction,	double-click	the	image	with	the	crosshair	cursor	(+).

To preview a redacted item:

1.	 Select	the	Mark for Redaction tool, if it is not already selected.

2. Hover over a redaction mark to preview it.

To delete a redaction mark:
1.	 With	the	Mark	for	Redaction	tool,	hover	over	the	redaction	mark	and	click	to	select	it.	You’ll	see	subtle	

animation around the edges.

2.	 To	delete	the	redaction,	press	the	Delete	key.	

Preview with cursor 
over redacted object

Normal view shows 
redacted information
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Changing the appearance of redactions
By	default,	redactions	appear	as	solid	black	rectangles.	You	can	change	the	appearance	of	redaction	marks.	
For example,	the	image	below	shows	different	options.

Redaction color Overlay	text Text color and repeat

Examples of customizing the appearance of redactions

 To change the appearance of a single redaction mark:

1.	 With	the	Mark	for	Redaction	tool,	hover	over	the	redaction	mark	you	want	to	change.

2. Right-click and choose Properties.

3. In the Redaction Properties window, select the changes that you want to make. The options are listed by 
letters	in	the	screenshot	below.
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Redaction Tool Properties window

To change the default appearance of all redaction marks:

1.	 With	the	Mark	for	Redaction	tool,	select	an	item	for	redaction.

2. Right-click and choose Properties. 

3.	 Specify	the	appearance	of	the	redaction	mark	and	click	OK. 

4. Right-click the redacted item and choose Make Current Properties Default.

Frequently need to change the color of redaction marks? 
Use	the	Properties	bar	instead.	To	open	the	Properties	bar,	press	Ctrl+E	(Windows)	or	Command+E	
(Mac).	Select	a	redaction	mark	and	change	its	color.

a.	 Choose	the	color	of	the	redaction.	You	can	also	choose	
no color.

b.	 Select	to	have	overlay	text	on	top	of	the	redaction.
c.	 Choose	the	font	for	the	overlay	text.
d.	 Set	the	font	size	for	the	overlay	text.
e.	 Select	Auto-Size	Text	to	make	the	text	fit	the	width	of	

the redacted area.
f.	 Select	to	repeat	the	text	over	the	redacted	area.
g.	 Choose	how	to	align	the	overlay	text:	left	justified,	

centered, or right justified.
h.	 Specify	the	font	color	of	the	overlay	text.
i.	 Select	to	enable	custom	text.	Type	the	text	to	appear	

on top of the redaction.
j.	 Select	to	apply	an	exemption	code.	Exemption	codes	

are	listed	in	the	box.	You	cannot	change	the	informa-
tion in this field. 

k.	 Select	a	redaction	code,	if	applicable.	Redaction	codes	
are pre-defined sets of text used to denote the reason 
or statute under which the redaction was made. 
Acrobat	Pro	includes	two	prepopulated	sets—	U.S.	
FOIA	(Freedom	of	Information	Act)	and	U.S.	Privacy	
Act.	You	can	also	create	and	save	your	own	sets.

l.	 Set	the	outline	color	for	the	redaction	mark.	This	
affects the appearance of the marked item only, not 
the final appearance of the redaction.

m.	 Set	the	fill	color	for	the	redaction	mark.	This	affects	the	
appearance of the marked item only, not the final 
appearance of the redaction.

n.	 Set	the	opacity	of	the	redaction	mark.	This	affects	the	
appearance of the marked item only, not the final 
appearance of the redaction.
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Deleting or changing multiple redaction marks simultaneously
The	Acrobat	Comments	panel	contains	a	list	view	of	all	redaction	marks	in	the	document.	From	there,	you	can	
delete or change the properties of multiple redaction marks at one time.

1.	 Click	the	Comment	panel	and	expand	the	Comments	List	section.

2.	 Do	one	of	the	following:

•	 To	select	non-contiguous	comments,	hold	down	the	Control	key	(Windows)	or	Command	key	(Mac)	and	
click the comments you want to remove or change.

•	 To	select	all	comments	in	the	list	or	comments	next	to	each	other,	select	the	first	comment,	and	then	while	
pressing	the	Shift	key,	select	the	last	comment	you	want	to	remove	or	change.

3.	 To	delete	the	comments,	press	the	Delete	key.

4. To change the properties of the selected comments, right-click and choose Properties.

Searching for text to redact 
The	Search	and	Remove	Text	feature	allows	you	to	search	for	single	or	multiple	text	strings	and	patterns,	such	
as	national	ID	numbers,	within	a	single	document	or	across	multiple	documents.

To search and redact text:

1. In the Tools panel, expand the Protection section.

2.	 Select	Search & Remove Text.

3.	 For	where	to	search,	select	the	current	document	or	browse	to	a	folder	of	files	to	perform	a	cross-
document search.

4.	 Select	what	you	want	to	search	for.	If	you	choose	Multiple Words or Phrase, the Words and Phrases to 
Search	and	Redact	dialog	box	opens.	Enter	each	word	to	search	for	and	click	Add or click Import to import 
a list of words.

5.	 Click	Search and Redact. When the search is complete, the results appear.

6. To view where a result appears in the document, click the result.

7.	 Select	the	results	you	want	to	mark	for	redaction.	To	mark	all	the	results,	click	Check All.

8.	 Click	Mark Checked Results for Redaction. 
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Using pattern-based search
You	can	search	for	particular	patterns	to	find	information,	such	as	phone	numbers,	national	ID	numbers,	email	
addresses, and dates. To create custom patterns, see the section, “Creating	custom	redaction	patterns.”

To search for information using a pattern:

1. In the Tools panel, expand the Protection section.

2.	 Select	Search & Remove Text.

3.	 For	where	to	search,	select	the	current	document	or	browse	to	a	folder	of	files	to	perform	a	cross-docu-
ment search.

4.	 Under	Search	For,	choose	Patterns.

5.	 Select	the	pattern	you	want	to	find.

6.	 Click	Search and Redact.	The	Search	dialog	box	opens.

7. To perform a new search, click New Search. 

8.	 To	save	the	search	to	a	PDF	or	CSV	file,	click	the	file	icon.

9. To view where a result appears in the document, click the result.

10.	 Choose	whether	you	want	to	mark	whole	or	partial	words.	For	partial	word	redaction,	click	Settings.

11.	 Select	the	results	you	want	to	mark	for	redaction.	To	mark	all	the	results,	click	Check All.

12.	 Click	Mark Checked Results for Redaction. 

Reviewing redactions
It’s	important	to	review	each	page	of	your	document,	especially	scanned	documents.	You	can	use	the	following	
familiar commenting and annotation Acrobat features to manage redactions:

•	 Add	notes	and	comments	to	redacted	items	and	send	them	to	another	Acrobat	user	to	review,	reply	to,	
or change.

•	 Summarize	comments	and	notes	attached	to	redacted	items	as	part	of	a	review	or	archival	workflow.

•	 Approve,	reject,	or	delete	items	to	be	redacted	using	the	Comments	list.

•	 Participate	in	a	Shared	Review	workflow,	which	allows	you	and	your	colleagues	to	use	Acrobat	X	Pro	to	
collaboratively redact documents.

To add a note or comment to an item marked for redaction, do one of the following:

•	 Right-click	the	item	and	choose	Open Pop-up Note.

•	 Double-click	the	item.

To	view	the	Comment	list:

•	 Click	the	Comments	panel	and	expand	the	Comments	List	section.
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Creating a redaction summary 
You	can	consolidate	the	comments	of	redacted	documents	in	a	single	PDF	file.	Redaction	annotations	are	
displayed as callouts on the document.

To create a summary:

1.	 Open	the	document	containing	your	redaction	marks.	You	must	run	this	step	before	you	apply	the	redactions.

2.	 Click	the	Comments	panel	and	expand	the	Comments	List	section.

3.	 In	the	upper	right	corner	of	the	Comments	List,	click	the	Options	icon	and	choose	Create Comment Summary.
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4.	 In	the	Summarize	Options	dialog	box,	choose	a	layout	option.

5.	 Click	the	Create PDF Comment Summary	button.

Acrobat	creates	a	PDF	file	that	summarizes	the	redaction	marks	using	the	layout	that	you	selected.	

Applying redactions
You	must	apply	a	redaction	to	permanently	remove	the	information	from	the	document.	All	graphic	objects	
such as text, raster images, or vector images that are fully covered by a redaction mark are completely 
removed from the document. All graphic objects that are partially covered by a redaction mark are modified so 
that only the covered area is removed. Any information associated with the graphic objects is also removed. 
After	the	redactions	are	applied,	Acrobat	prompts	you	to	save	the	PDF	document	as	a	new	file	and	will	only	
include valid objects. This method prevents removed objects from being viewed or recovered in the future.

To apply redactions:

1. In the Tools panel, expand the Protection section.

2.	 Select	Apply Redactions.

3. In the warning window, click OK if you want to remove the information. 
The redactions are applied. 

4. In the message prompting you to examine the document for additional information, click Yes. This action 
finds hidden information, such as metadata, text, and comments, that could lead to an accidental disclosure. 
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5.  Review the results and then click Remove.

6.	 Choose	File	>	Save.	Acrobat	renames	your	file	automatically	when	you	save	it.
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Automating	Redaction	Workflows	Using	Actions
You	can	use	guided	Actions	in	Acrobat	X	to	automate	many	of	the	steps	in	the	redaction	process.	With	guided	
Actions, users are automatically taken through each step and prompted as appropriate, ensuring process 
consistency	and	minimizing	the	user’s	learning	curve	for	Acrobat.	For	example,	you	can	have	an	Action	that	
performs the following steps:

1. Prompts you to locate the documents to redact.

2.	 Converts	them	to	PDF	(for	supported	file	types	like	Word	or	Excel).

3.	 Performs	OCR	on	the	document,	if	needed.

4. Prompts you to redact the document.

5. Applies the redactions.

6. Removes hidden information and metadata.

7. Reduces the file size of the document.

8.	 Changes	the	file	to	an	Acrobat	5	level	file	(PDF	1.4),	which	is	compatible	with	court	filing	systems.

9. Renames the file with the _redacted.pdf suffix.

10.	 Saves	the	redacted	documents	in	a	folder	of	your	choosing.

Download	the	above	example	action	along	with	instructions	(Redaction_Action.pdf	).

You	will	need	Acrobat	X	Pro	to	run	the	Action.

PDF	file	includes:

•	 Installation	information

•	 Embedded	Action

•	 Instructions	on	how	to	use	the	Action

•	 Customizing	information

Redaction_Action.pdf (674K)

http://blogs.adobe.com/acrolaw/files/2010/12/Redaction_Action1.pdf
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Tips and tricks for advanced users
Creating custom redaction patterns
Acrobat	uses	regular	expressions—often	abbreviated	as	REGEX—to	find	patterns.	A	regular	expression	is	a	code	
pattern	that	describes	the	attributes	of	the	text	that	you	want	to	find.	For	instance,	if	you	need	to	find	uniquely	
patterned	account	numbers,	you	can	use	a	REGEX	to	find	the	pattern	and	mark	all	account	numbers	across	
many	documents.	For	example,	for	the	pattern	of	three	alphabetic	characters	followed	by	three	digits,	the	
REGEX	is	\D\D\D\d\d\d.	This	pattern	would	find	ABC123,	but	not	123ABC	or	A12345.	

Several	third-party	tools	are	available	for	building	regular	expressions.	For	example,	RegexBuddy	(www.
regexbuddy.com)	is	a	Windows-based	application	for	creating	and	testing	regular	expressions.	It	also	comes	with	
a	library	of	prebuilt	expressions	for	various	patterns,	such	as	postal	codes,	national	IDs,	and	VAT	country	codes.

After you have created and tested a regular expression, you can add it to Acrobat.

Acrobat pattern files

Acrobat	stores	redaction	patterns	in	an	XML	file	called	SearchRedactPatterns.xml.	You	can	edit	the	file	in	a	text	
editor	like	Notepad	(Windows)	or	TextEdit	(Mac).	Before	making	changes,	make	a	copy	of	the	file.	You	can	use	
existing	patterns	as	a	template.	Copy	the	text	you	want	to	modify	and	place	it	at	the	end	of	the	file,	and	then	
make the changes to create a new pattern.

Tip:	It’s	easier	to	edit	the	XML	file	in	an	application	that	understands	tags,	such	as	Adobe	Dreamweaver®	
or Microsoft	Word.	

Creating a new pattern 

To create a new pattern:

1. Quit Acrobat if it is open. 

2.	 Find	the	search	pattern	file:	

•	 (Windows	XP)
	 \Documents	and	Settings\<username>\Application	Data\Adobe\Acrobat\10.0\Preferences\
Redaction\<locale>\	SearchRedactPatterns.xml

•	 (Windows	7	and	Vista)
	 \Users\<username>\AppData\Roaming\Adobe\Acrobat\10.0\Preferences\Redaction\<locale>\ 
SearchRedactPatterns.xml

•	 (Mac	Intel)	
	 /Users/<username>/Library/Preferences/Adobe/Acrobat/10.0/	Redaction/<locale>/ 
SearchRedactPatterns.xml

 Can’t see the file on Windows? 
	1.	 In	the	Control	Panel,	choose	Folder Options. 
	2.	 Click	the	View tab. 
	3.	 Double-click	Hidden Files and Folders. 
	4.	 Enable	Show hidden files and folders.

3.	 Make	a	backup	copy	of	the	SearchRedactPatterns.xml	file.

4.	 Open	SearchRedactPatterns.xml	in	a	text	editor.

http://www.regexbuddy.com
http://www.regexbuddy.com
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5.	 Locate	a	pattern	to	modify.	This	example	uses	Entry4.

<set	name=”Entry4”>
<str	name=”displayName”>
<val>Email	Addresses</val>
</str>
<str	name=”regEx”	translate=”no”>
<val>([a-zA-Z0-9_])([a-zA-Z0-9_\-\.])*@([a-zA-Z\-])+\.([a-zA-Z\.]+)</val>
</str>
<str	name=”examples”>
<val>This	pattern	will	search	for	email	addresses.

For	example:
John.Doe@acme.com
John_Doe_1234@acme.gov
j-doe@marketing.acme.net</val>
</str>
</set>	

6.	 Copy	the	block	of	text	and	place	it	just	before	the	last	tag	in	the	file:	</asf>.

7.	 Edit	the	block.

a.	 Give	the	block	a	unique	entry	number.

b.	 Change	the	display	name.	This	name	appears	in	Acrobat.

c.	 Edit	the	pattern.

d.	 (Optional)	Provide	a	description	and	examples.	Although	this	is	optional,	it	is	helpful	for	other	users.

Careful!	Do	not	delete	any	quotes	(“	“)	or	brackets	(<	>).	 
Only	fill	in	between	the	opening	<val>	and	closing	<\val>	tags.	
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For	example,	a	new	Entry	6	for	Canadian	Social	Insurance	numbers	looks	like	this:

<set	name=”Entry6”>
<str	name=”displayName”>
<val>Canadian	Social	Insurance	Number</val>
</str>
<str	name=”regEx”	translate=”no”>
<val>(\b)((\d{3}(-|\s|\.|_)\d{3}(-|\s|\.|_)\d{3})|(\d{9}))(\b)</val>
</str>
<str	name=”examples”>
<val>This	pattern	will	search	for	9-digit	Canadian	Social	Insurance	numbers,	either	consecutive	or	3	digits	plus	3	digits	plus	3	digits	
(separated	by	punctuation	marks).

For	example:
123-456-789
123456789</val>
</str>
</set>	

8.	 Save	the	file.

9. Restart Acrobat.

10.	 Choose	View	>	Toolbars	>	Redaction	and	then	click	the	Search	and	Redact	button. 
The new pattern should be in the list.

I edited the file, but the patterns aren’t there! 
Make	sure	that	you	edited	the	file	in	the	Preferences	folder.	 
There is an identical file one level up that is easy to grab by mistake.

Adding overlay text and exemption codes to a redaction mark
Overlay	text	appears	on	top	of	a	redaction	mark	and	remains	present	after	redactions	are	applied.	The	overlay	
text	is	useful	for	government	agencies	that	are	required	to	make	documents	public	or	to	place	a	code	or	other	
mark on top of the redaction to meet agency guidelines.

To add overlay text to a redaction mark:

1.	 Create	a	redaction	mark.

2. Right-click the redaction mark and choose Properties.

3.	 Select	Use	Overlay Text.

4. In the Custom Text field, type the overlay text.

5.	 Click	OK.
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To add an exemption code to a redaction mark:

1.	 Create	a	redaction	mark.

2. Right-click the redaction mark and choose the appropriate custom exemption code that appears in the 
menu and the appropriate code.

3. Repeat for as many exemption codes as needed per redaction.

Creating custom exemption code sets
You	can	create	custom	exemption	codes	to	add	to	a	redaction	mark.

1.	 Create	a	redaction	mark.

2. Right-click the redaction mark and choose Properties.

3.	 Click	the	Edit Codes	button.

4.	 Click	the	Add Set	button.

5.	 Change	the	name	of	the	set	in	the	entry	field,	and	click	the	Rename Set	button.

6.	 Click	the	Add Code	button.

7.	 Change	the	name	of	the	code	in	the	entry	field,	and	click	the	Rename Code	button.

8. Repeat step 7 for as many codes as needed.

9.	 Click	OK when you are finished.

Best practices summary
Keep	in	the	mind	the	following	when	taking	on	projects	that	require	redaction.

•	 Do not forget to apply redactions!	Simply	marking	text	and	graphics	does	not	actually	remove	it.	

•	 Streamline	the	redaction	process	using	Acrobat	X	Actions.	You	can	use	Actions	to	do	the	following:

 – Prompt users to manually redact pages

 – Perform	Word	List	redaction

 – Apply redactions 

•	 Carefully	review	scanned	documents	because	OCR	is	not	a	foolproof	process.	The	Search	and	Redact	feature	
finds text only in searchable documents. 

•	 Review	all	documents	prior	to	submission.	A	two-person	review	team	catches	many	more	errors	than	a	
single person. 

•	 Know	your	court	rules	and	judge’s	orders	regarding	redaction.	Ask	the	clerk	of	the	court	for	clarification	if	you	
need more information. 

•	 Don’t	skip	the	examine	document	step.	Inexperienced	users	might	only	cover	up	information	in	electronic	
sources	and	mistakenly	believe	it	is	redacted.	The	Examine	Document	feature	can	detect	and	fix	these	issues.	
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